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Introduction

Control systems for large scientific and industrial facilities are highly complex systems. They control
hundreds or thousands of devices of many different types, through a variety of interfaces. Good
monitoring and control is mission critical to these facilities.

The TANGO control system is a free, open source control system that is being collaboratively
developed between the ALBA, ANKA, DESY, Elettra, ESRF, FRM Il, MAX-IV, Solaris and Soleil Institutes,
with the specific aim of managing this complexity in a contemporary and powerful fashion.

Tango is object-oriented and distributed. This makes it both flexible and developer friendly.

The purpose of the Tango Box Virtual Machine is to give you a fast, out-of-the-box experience of a
working Tango system. There is a limited set of shortcuts to essential Tango tools on the virtual
machine desktop. Together with the introductory movie video and this user manual, they allow you
to experience the power and elegance of the Tango system first hand. After this "guided tour" of the
Tango system, Tango Box is an excellent tool to make further explorations on your own, to use it for
demonstration purposes, to make studies, proof-of-concepts and the like. This way, out of this little
box, another great, sophisticated control system for the real world gets maybe born!

e ANKA
AL BA

MAX-Iab ®%> SOLARIS  SULEIL
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Overview of Tango (Box

TANGO consists of a number of main parts: one is a software bus, or TANGO kernel. It is a system
that lets TANGO clients monitor and control equipment through TANGO device servers. This
communication between clients and servers can be both synchronous, asynchronous or event driven.

Another part is the central services. A configuration database contains all configuration data
(runtime attribute and property values that differ between instances of the same device type/class,
do not belong in code, and need to be managed in central repositories for these large systems to be
maintainable). An archiving service allows historic values of the attributes to be stored and retrieved.
A snapshot tool allows a system state to be saved to persistent storage and to restore that state to
the machine. An alarm system signals parameter values approaching or reaching values outside
normal operating ranges and potentially damaging to the machine. Finally a diagnostic logging
system logs diagnostic messages for later analysis.

A third major part is a set of tools that allow administration of the TANGO system. It is through these
tools that we will experience the running TANGO system on the Tango Box VM. lJive is TANGO's
database browser, providing hierarchic access to TANGO's Servers, Devices and Classes. Astor is the
Tango Manager for controlling, starting and stopping TANGO device servers. AtkMoni is a tool for
charting and monitoring device variables (attributes). A complete list is in Table 1: Summary of key
TANGO Box tools.

A set of tools worth mentioning in its own right is Sardana. Sardana is a standard generic user
environment built on top of TANGO, specifically for realizing control applications that require
sequencing of fast and slow controls, e.g. beamlines and their experiments. It is exposed through the
Spock and iTango shortcuts on the Tango Box desktop.
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Setting up your System
Installing VMwarePlayer |

Installing VMware Player

TANGO Box is a virtual machine that is based on the Ubuntu operating system and the easiest way to
run TANGO Box is to use VMware Player which allows you to run images of different operating

systems on your existing system. Download VMware Player [1] and install according to the
instructions provided.

Download TANGO Box

The TANGO Box image which is run in VMware Player can be downloaded from the TANGO website
[2].

Note: The extraction from the archive can take several minutes.
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Running TANGO Box
'@ VMuware Player (Non-commercial use only) l = | &= 1 &2 |

Player vl R A i § o

Welcome to VMware Player

Create a New Virtual Machine

@ centos-5,41386-server A 4) Create anew virtual machine, which will then be

added to the top of your library.
@ Ubuntu 10.10 Tools

@ TangoBoxV2 ﬁﬁ Open a Virtual Machine
N

Open an existing virtual machine, which will then be

VM-DEV-2.0-V52010
@ added to the top of your library.

@ Other j a\ Upgrade to VMware Workstation
| Get advanced features such as snapshots,
@ centos-5.5-x86_64-server ’ developer tool integration, and more.

@ CentOS-5. 5-386-virtual-machine-org

‘ . Help
@] FeEehs \ | View VMware Player's help contents
\_ / ew ware Player s neip contents.

This product is not licensed and is authorized for
non-commercial use only. For commerdial use,
purchase a license. Buy now.

Figure 1: VMware Player opening screen

1. Launch VMware Player > Open a Virtual Machine.
2. Select TANGO vbox_3 @.vmx.
3. If you are presented with a dialog = | copied it.

tango_vbox_3_0 - VMware Player g

This virtual machine might have been moved or
copied.

In order to configure certain management and
networking features, VMware Player needs to know
if this virtual machine was moved or copied.

If you don't know, answer "I copied it".

Figure 2: VMware Player confirmation dialog
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Whetting your Appetite

A Quick Out-of-the Box Experience

Experiencing a TANGO System running a Motor Simulator

1. Launch Jive from the Desktop.

@ tango_vbox_3_0 - VMware Player (Non-commercial use only)

Player ~ | [ v oFy B @

E e @% \p_v? ,ﬁ_ PWD: guest_test
_— File Edit Tools Filter
= Class | Alias | Property |
Server I Device ] 4
— B
‘ , o % DataBaseds .
b= o % LimaCCDs Jive 4.24 [tangobox:10000]
= i ';"aclmse"'ef File Edit Tools Filter
g Pool -
A o % PySignalSimulator Class | Alias |  Property | Dewc.e Info
: o~ % SimMotor Server d Device ¢ DEvIEeRINTONs deismial demsisnte ety 4oy
?s at
’ : & :tarte; e o % DataBaseds Device: sim/motor/1
S AngoAecessControl o % LimaCCDs ftype_id: IDL:Tango/Device_4:1.0
il
5 & TangoTest o4& MacroServer || iiop_version: 1.2
= ),. &% Pool host tangobox.local (192.168.1¢
o % PySignalSimulator ports 2E78S
p— bR Server: SinMotor/tangobox
? ‘—ﬂmMotor Server PID: 2968
HED ‘ ¢ % tangobox [0y Exported: true
—l ¢ & simMot ast_exported:  28th June 2013 at 10:17:2¢
m— @ simy| Paste ast_unexported: 6th June 2013 at 22:31:47
. ? -
r o @4 F Rename
8 & Ff Delete - Polling Status ------=-=cecomomomoaoaoos
e EA E Monitor device
& 4 Test device
\ Define device alias
o @ simyj Go to device node
o (8 simji Restart device
o % Starter Device wizard
o % TangoAccess! Log Viewer
o % TangoTest

TANGA,
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L

Figure 3: Jive screen showing hierarchy of device server (SimMotor), device server instance (tangobox), device class
(SimMotor) and device class instance (sim/motor/1)
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Click on SimMotor - TANGObox.

Right click on sim/motor/1 and select Monitor Device.

Repeat above to open a second “Monitor Device” window for sim/motor/1.
This opens the auto-generated device client.

vk wnN

1y ) 10:24AM
% %} \"17 Q. PWD: guest_test

Class roperty Device Info

.
[ <l
R AtkPanel 4.4 :sim/motor/1
>_ ’ s %Dataaasad— File View Preferences Help File View Preferences Help
L] o %7 LimaCCDs
= IS e — e ——
A a
: g g‘ﬁgsi‘ﬁlm sim/motorfl sim/motor/1
g ¢ ¥ tangoha] [Pevice is OK <] | [peviceis oKk B
7 &l Simi
o & s
* e ! -
hy S o 4@ si
o % Starter ettt Attt =
o % TangoAcce AAL A
o & TangoTest StepSize [10.000 mm 585 00 L] StepSize [10.000 mm 000.00 [
FIV IV ¥YY YY
YYYVYVYVY YV
Steps | 500 steps 000500 Steps | 500 steps 000500
P P FYYYYY L] P P SETYY L]
—
AAAA AM - Abbd Ahd
' position | 5.000mm | 0005 .000 || position [ 5.000mm 0005 .000 | |
T 7 7 FY¥VY VIV
"_ low limit switch state [] E| low limit switch state [] D
l up limit switch state [] El up limit switch state [ El
Home_side [] El Home_side [ ] D
Instantanecus speed | 0,00 mm/s El Instantaneous speed | 0.00 mm/s D
Scalar | Scalar
o I A N G,Q.
‘ Connecting things together

Figure 4: AtkPanel showing attributes for sim/motor/1. The position of the motor can be changed by using the controls
indicated by the blue arrow.

6. Change the motor position using the controls indicated by the blue arrow.



Page7

TANGA.

Connecting things together

13 @) 11:00AM %

PWD: guest_test

File Edit Tools Filter

Class | Alias | Property | | Device Info
Server |’ Device - Device INfo ----c-meccrnimmcmimcn e e e

o & DataBaseds Device: sim/motor/1
o % LimaCCDs ftype_id: IDL:Tango/Device_4:1.0
o ¥ MacroServer 2 liiop_version: 1.2 |
o & Pool host : tangobox.local (192.168.149.131) |
B port: 58763 |
o % PySignalSimulator |
:?' y 9 Server: SimMotor/tangobox |
¢~ % SimMotor ||[server PID: 2968 |
¢ & tangobox || [Exported: true |
¢ &l SimMotor ast_exported:  25th June 2013 at 10:17:26
o & sim/motor/l ast_unexported: 6th June 2013 at 22:31:47

o & sim/motor/2
o B sim/motor/3
o % Starter
o~ % TangoAccessControl
o % TangoTest

=< POLLINg: StAtUS isnmr wnn samr wnme dmmr vmne S i S

File View Preferences Help

B sim/motor/1 :[E]

EE]

C

EECICE]

¢ 3 Trend
sim/motor/1 ¢ 3 sim/motor/1
Device is OK =] position
10
~| 9|
5 AAA AL e
StepSize [10.000 mm 000.00
YAl A
AAAAAAL
Steps | 600 steps 000600
YYYYYY
(i AAAL AAA L
position | 6.000mm 0006.000
¥YYY YIY

low limit switch state []
up limit switch state []

Home_side []

A ann 7
Scalar

Figure 5: AtkMoni (Trends) showing the trend over time of the Temperature attribute for sim/motor/1.

IEIEIE] B B E

7. You can view how the motor position is changing by launching AtkMoni. Click on Add New

Attribute (toolbar button LE) and select in the tree: sim - motor - 1 - position. Then
right-click on the position attribute and choose "Add to Y1". Then click on Start Monitoring

(toolbar button LH). Now, if you change the position in Jive, you can see the position
change in AtkMoni.
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1y ) 10:40AM %

st
File View Preferences Help

> 1 File Edit Tools Filter
= __ Class W Froperty | [ Attribute configuration [sim/motor/2]
. 1 Server I Device | Display | Unit ["Range | Alarms | Description | N sim/motor/1 I:lzl ‘
E o % DataBaseds ‘ Attribute name Label Format i
o % LimaCCDs |Acceleration Accelera,., [%4d ot/
f 1 o % MacroServer Backlash Backlash |%5.3f Pz 0 (L =
o % Pool Firstvelocit first step... %4d
o % PySignalSimulator HardLimitHigh up limit s... |%6.2f
I 1 ¢ % SimMator HardLimitLow low limit ... [%6.2F =
E ¢ % tangobox Home_position Home po...|%7.3f
A ¢ &l simMotor Home_side Home side |[%6.2f 2 : 2
I 1 o 4 sim/motor/l InstantSpeed Instanta... [%6.2f Adh AA
E 948 sim/motor/2 Position position  |%7.3f StepSize [10.000 mm 000 .00
o~ [%8] Properties PresetPosition Preset P... %.3f TV V7
& Poliing State State %6, 2f ’7 AAA AL
8 E& Event Status |§tatus %6.2f Steps | 500 steps 000500
[%) Attribute config Steps |Steps %6d FYYVVY
o [y Attribute properties Steps_per_unit |Steps pe...|[%7.1f AAAA AMA
e gl | oaaing epsize socize o position | 5.000mm 0005 .000
[ :I Terminal TY¥Y FVY

- An interactive client. low limit switch state []
up limit switch state []
Running on top of Python 2.7.4, IPython ©.13.2 and PyTango 8.0.3 ‘
Home_side []
-> ITango's help s B Instantaneous speed | 0.00 mm/s
> Details about ct'.

?object also works, ?? prints more.

EIEEEIE Bl E

Scalar
IPython profile: tango

1]: PyTango.DeviceProxy("sim/motor/1").position = 4f

Figure 6: iTango terminal

1. LaunchiTango
2. Enter (copy) the command into the iTango console.

PyTango.DeviceProxy("sim/motor/1").position=4

Motor can be seen to be moving in the ATKPanel.

When typing, try pressing <tab>. Since iTango has autocomplete embedded

you get a list of possible completions. Example:
PyTango.Release.<tab>
Tip Gets a list of all members of PyTango.Release class. Equally:

PyTango.DeviceProxy ("sim<press tab key>

Gives a list of available runtime options
sim/motor/1  sim/motor2 sim/motor3

We put the command in line of Python code to save you a copy-paste.

The following works equally well of course:

Note

motorl = PyTango.DeviceProxy ("sim/motor/1")
motorl.position = 4
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As we will see further, Taurus is a library to create GUI's for the TANGO system in Python. It comes
with a collection of demos. We will use one of them as a starting point for this demo.

In a new terminal window type:

taurusform sim/motor/1

This launches the form below, which provides again access to the various motor attributes. We leave
it to the reader to explore the GUI, change values and observe the synchronization via the TANGO
device server of these two TANGO device clients: the ATK-based monitor panel and the Taurus based
form.

: sim/motor/1

SIM/MOTOR/1 (|

8 state [IIINGH @

Attributes | Commands

Acceleration [0 | 10| stepsfsh2 |
Backlash [0 0.000 | 0.000 | mm
first step velocity [y | 0  steps/s
up limit switch state -
low limit switch state -
Home position [0 0,000 | 0.000 | mm
Home_side -
Instantaneous speed [ 000 mmy/s
( position] 16000 | 5.000 | mm
( Preset Position] [ 0000 | 5.000 | mm
Stepsize 10,000 | 0.000 | mm
Device is OK

Figure 7: Taurus Form for sim/motor/1
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JDraw is the TANGO synoptic editor. You can use to construct (draw) synoptic screens, i.e. GUI's with

graphical representation of the physical layout of the device to be controlled by TANGO.

1. Launch JDraw

JDraw Editor 1.13

File Edit Create Views Tools

o= [ controller
o [ Door

o= [ dserver

o [ expchan
o[ LimacCcDs

o= [ MacroServer
o [ mntgrp

o= [ motor

o= [dpm

o= [ Poal

o [ PySignalSimulator
o= [ sim

o ] sys

o [Jtango

o= Jtest

DI” ‘3'(’” %I IEI I!I‘ g‘li\l 100% ‘m‘dlg %IFI EIIDIEI

[»

[«]

1]

[T

2. Open the file synoptic demo.jdw.

Look In: |ﬁ guest

0O-0-
MEEIEEEES

es ] Taurus C www

go CJtmp [y core

na Jtools |D synoptic demo.jdw |

Jvideos

_classes ] vmware-tools-distrib

BoxGui [J workspace

4] | Il [»

File Name: |synoptic demo.jdw |

Files of Type: |All Files '~
Open || Cancel |
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You see a graphical representation of a beam line with its optics elements. To provide a live demo of
TANGO synoptic screens, the right-most slit is already associated with the State of our sim/motor/1
from the previous examples

3. You can see the associated object by double-clicking on the slit. The Object name field in the
dialog that opens reads: sim/motor/1/State.

fy @) 1033am {f

Eile Edit Create Views Tools

RER = =[5 [ o T [ S

¢ dserver EXP EH3
o [F expchan

o [JLimaccDs
o[ MacroServer
o [J mntgrp
o I matar
- E3pm
o [JPoal
o [3 PySignalSimulator
o3 sim

o ays Colors Mirrer " germanium
¢ [Jtango Foreground - Background I:l Sequencer HDB Storage
edtest || P A n - -

= Styles

Line style : Line width OE

Fill style ‘No fill ‘V‘ ‘ Gradient settings |

OPTICS HUTCH 1

Camera Y Properties [1 JDGroup selected]

Y ntend
dte w d - Ltter
Object name XBP! 1 17

|5\mﬁmoton‘1f5tate H Apply | ¢ ¢ Pindiode

Extensions

W Screen

DaBOmas:

|

[¥] wvisible [ Anti alias

Shadows

[]shadow [l Invert Thickness IE
Coumes |

D

4. Before we go to live view let us associate the leftmost slit (slit2) as well with a motor:
sim/moter/2. Double-click it and type in Object name: sim/motor/2/State and click apply

5. Go to Views -> Tango Synoptic view. Now if we change the position of any of both motors in
ATKPanel, we see that the slit in the synoptic view indicates that a movement (blue color) is
occurring.

AtkPanel 1y W) 1037AM F

File Edit Create Views Tools

o= controller
oI Door
o= [ dserver
o [Jexpchan

o 9 LimaccDs

o= [ MacroServer

File View

= AtkPanel 4.4 : sim/motor/1 OPTICS HUTCH 1

File View Preferences Help

sim/motor/1 l:lzl

o 3 PySignalSimulator zﬁfﬁir

o9 sim

sim/motor/L

[T sys Device is OK E
o [Jtango A
o [Jtest :[H]: ¢ Pindiode
- Screen
MIFrer— germanium
= = : /B R —
1 Add Ad Screen - -
StepSize |10.000 mm 000 .00
= P FIT VT El
I Steps | 7086 steps 0oo7sE ]
FITTFT7T
|.I " AAMA AAA
position [ 7.080mm| | 0007 .580][ ]
YITY TV
low limit switch state [ ] El
up limit switch state [] El
Home_side [] E|
Instantanecus speed | 0.31 mm/s E|
| scalar
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TANGO Box Tools Overview

Now that you have had a taste for running TANGO, we can examine some of the tools that are
packaged with TANGO. These tools have shortcuts on the desktop and are summarised in Table 1.

Table 1: Summary of key TANGO Box tools

Tool Purpose

Astor/Starter The Astor/Starter pair of applications will help you to administer your control
system (Starting/Stopping device server, checking them, etc.). Astor is a graphical
application and Starter is the name of the device server used by Astor.

ATK TANGO Application ToolKit (ATK) is a java graphical layer for building GUIs for
TANGO.
ATKPanel ATKPanel is a generic application which displays panels allowing you to execute

any device commands or to read/write any device attributes

ATKMoni AtkMoni is the tool to view how your data is changing.

Eclipse Widely used development environment

iTango iTango is a PyTANGO CLI based on IPython. It is designed to be used as an IPython
profile.

JDraw Synoptic editor to draw your synoptic(s) to control TANGO devices (To be used
with ATK)

Jive The TANGO database browser and device testing tool

Netbeans Alternate development environment

Pogo Allows you to create/update TANGO device classes in C++

Spock Spock is an iTango based CLI (command line interface) for Sardana.

Spock has been extended in Sardana to provide a customized interface for
executing macros and automatic access to Sardana elements.

TaurusDesigner Powerful TANGO client GUI designer. It is a Qt designer application customized for
taurus
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The Elegant TANGO Architecture: A Quick

Overview

Java, C++,Python Linux, Windows, Solaris

MATLAB s /
“ 000000 et

REVSCHEN | IGOR Pro.
TANGO Software Bus ]
00008

Linux, Windows, Solaris x\flj Labview RT '

Woooor

Figure 8: Overview of the TANGO Architecture

The following provides a short description of the main architectural elements of the TANGO system
to provide the system context. In the next chapter we look into more detail into those elements that
are most relevant to the programmer/user of the TANGO system: the OO aspects.

TANGO is based on the concepts of object oriented and service oriented approaches to software
architecture. The object model in TANGO supports methods, attributes and properties. In TANGO all
objects are representations of devices.

TANGO is primarily used to provide network access to hardware. Hardware access is programmed in
a process called a Device Server. The device server implements device classes which implement the
hardware access. At runtime the device server creates devices which represent logical instances of
hardware. Clients "import" the devices and send requests to the devices using the TANGO protocol.

The object model in TANGO supports methods, attributes and properties. In TANGO all objects are
representations of devices. The devices can be on the same computer or distributed over a number
of computers interconnected by a network. The network communication is done using
CORBA. Communication can be synchronous, asynchronous or event driven. Configuration data is
stored in a database. Programming support is provided for C++, Java and Python. Clients can be
written in all three languages. Servers can also be written in C++, Java or Python. TANGO provides a
kernel API which hides all the details of network access and provides object browsing, discovery
and security features.
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Some ready to use graphical applications (DeviceTree, ATKPanel, ...) allow you to graphically display
data coming from your device(s). Graphical layers above the kernel APl have been developed to
reduce specific graphical client software development time. One exists for Java SWING (ATK),
another and another one for Python PyQt ( ).

TANGO uses CORBA (synchronous and asynchronous communication) and zeromq (event based
communication) and is a distributed control system that can run on one or many machines.

TANGO uses the omniorb implementation of CORBA as its network protocol. The client-server model
is the basic communication model. Communication between clients and servers can be synchronous,
asynchronous or event driven.


https://www.tango-controls.org/download/index_html#atk
https://www.tango-controls.org/static/taurus/latest/doc/html/index.html
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TANGO is Programmer Friendly!
It is Object Oriented |

It is Object Oriented

TANGO uses concepts (& constructs) from object oriented programming languages to help manage
the inherent complexity of large control systems.

For example there will be many instances of the same piece of hardware equipment in the entire
system, for example magnet power supplies. Where at runtime the currents they supply will be
different, they obviously share many properties that are the same (e.g. you interface to them in the
same way). In OO this static commonality is captured in a Class and the differences in run-time
objects or instantiations of that class. That is exactly what TANGO provides for us. TANGO Device
Classes and TANGO Device Instances. The SimMotor that we saw in the Wetting Your Appetite
chapter is an example of a Device Class, "sim/motor/1", the name of a Device Instance.

Being able to build hierarchies of things (objects) of specific types is another powerful concept of the
OO0 world. A TANGO system has such a hierarchy and it supports its distributed nature. Here we
introduce the concept of a TANGO Device Server (DS). Essentially the DS is the process in which
Device Instances (of Classes) are running. The TANGO system allows setting it up in this flexible way:

A Tango device server
LimaCCDs/simulator

Tango device class
LimaCCDs

- -

Tango device class
LimaTacoCCDs

-
- -
- ~

- ~

. 7 . \\ ) ~
. Device d Device y Device /" Device \\‘
Ll_maCCDs./ ; LljmaCCDS/ ! limaccds/ /" limaccds/ !
simulator/ X simulator/ K limatacoccds/ '. limatacoccds/ K
~ 2 ’

~ -
~ -

P
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So, one Device Server (process) can run multiple instances of multiple device classes!

(Note: the dotted line around the second instance is because in your Tango Box, there is only one
instance at start-up, but there could be more)

If we apply this to our example of the multiple power supplies, we see TANGO offers us many ways
to set up this system, depending on the physical layout and other parameters of the machine. If two
power supplies are close to each other, we can control them from one PC (crate), with one device
server process, or with two device servers, on the same host machine. If they are far from each
other, we could control them with two device servers on two separate host machines. TANGO is not
putting any restrictions on our system configuration here. And for the TANGO clients, this is all
transparent. An important consequence is also we can redesign the physical layout of the system,
without a big impact on the software clients.

Device Attributes, Properties, Commands and State

Encapsulating data and behaviour into single entities is another important OO concept; it is an
improvement over how you can model, represent the real-world in your code, compared to older
programming techniques.

TANGO uses these concepts to represent the physical equipment the system is controlling. But as we
will see it goes beyond having the data in data members and the behaviour invoked through
methods: A Tango device class has additional provisions that are essential in the domain of control
systems.

First there is the distinction between attributes and properties. In general OO terminology they are
used interchangeably. In TANGO, the attribute is used to represent process variable, physical values
like current, voltage, temperature, ... they are supposed to vary continuously. Properties are much
more static, they are the things you need to set up once for the software device to work, to connect
properly to the physical equipment etc. Typical example is a IP address.

Attributes have a set of domain-specific meta-data. Just to name a few important ones: the physical
unit (Ampere, mm, ...), range values, alarm values.

Commands are the "dials and knobs" of the device. In a distributed system it is essential that you can
distinguish between synchronous and asynchronous calls. TANGO supports that.

A last OO0 concept we mention is the "state" of the class, i.e. technically is that combined values of all
data members. In control systems it is worth to be more specific, to model devices as state machines
with a set of predefined states and transitions between those states. TANGO provides that: by
default, TANGO classes have a state attribute for this purpose and there is a set of predefined states:
ON, OFF, OPEN, CLOSE, MOVING, ...

Let us conclude the brief introduction on the OO concepts used in TANGO here. The TANGO
architecture relies heavily on more advanced concepts and techniques of the OO world, such as
design patterns, but a discussion of this is outside of the scope of this VM User Manual. Please refer
to the following sources for more information:


http://www.tango-controls.org/device-servers/abstract-classes/Abstract_Device_Pattern.pdf
http://www.esrf.eu/computing/cs/tango/tango_doc/kernel_doc/ds_prog/node9.html#SECTION00912000000000000000
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Python powered tools: iTango, Sardana & Spock

Programmer friendliness is also greatly enhanced if you can interface dynamically with a system
through an interpreted, high-level programming language such as Python.

powerful GUI building

Taurus Designer is a powerful TANGO client GUI designer. It is based on QtDesigner, and extended
with additional Taurus widgets and functionality to serve for the purposes of TANGO development.
With this tool, it is possible to assemble and configure a TANGO client GUI, without the need to
modify the code itself.

In this section, we will construct such a simple client that will include most common Taurus widgets
for extracting and writing data from and to a device.

1. Open Taurus Designer by typing in a terminal window:

taurusdesigner

2. Create New Form

In the first window, you can select a type of the form that will be used. You can choose from
preassembled templates, widgets or any custom user widgets. In the “templates/forms” section,
select a “Widget” and create it.

3. Adding a new Label for Title

A standard Label is used for displaying a String. On the left, in the “Widget Box” section, under
“Display Widgets”, you will find a “Label” widget. Drag it onto your form. Position it, double click
it and set the string to display a desired message/title. In the property editor on the right, you
can modify it furthermore. Change the “objectName” to a meaningful name, e.g. "title" and
modify the font, e.g. to font size 14.

(> Qt Designer 1

el BD HERE WEWEE# SN
Widget Box ® - Object Inspector i3]
label Q Object Class -
: . . ] v 5% Form [2] Qwidget
Display Widgets &im Notorf title © QLabel
{) Label
Taurus Displa
play Property Editor =
{) TaurusLabel )
Qwt Widgets Filter |:I‘}=, =
title : QLabel
Property Value
objectName title
enabled
> geometry [(140, 20), 91 x 17]
» sizePolicy [Preferred, Preferred, 0, 0]
» minimumsize 0x0
» maximumsSize 16777215 x 16777215
> sizelncrement ox0
> baseSize 0x0
palette Inherited
¥ font A [Ubuntu, 14]
Family Ubuntu
Point Size 14
Bols
1kalis
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4. Attribute Readout

Create a new Label for displaying the name of the attribute.

Create a new TaurusLabel for displaying the actual value of the attribute. You will find it in the
Widget Box under Taurus Display. Drag it onto the form. In order to connect this field to an
actual device, all you have to do is to specify the device and the attribute. In the Property Editor,
change the value of “model” to “sim/motor/1/position”, where “sim/motor/1” defines a device

and “position” defines the attribute of the device.

Qt Designer
Db DD HERE T HMETHEERN
Widget Box [E5] Object Inspector [E3]
o Form - untitled == 5
Object Class
A . v 5 Form [~] Qwidget

[ TaurusAttrForm Sim Motor label © QLabegl

Taurus Views . oonon ta...el > TaurusLabel ~

position: Lo

AlEUsiE oS e Property Editor ®
| TaurusLa...erButton
@ TaurusCo...ndButton Elﬂiiv = S~
@ TaurusLockButton taurusLabel : TaurusLabel

Taurus Input Property Value
[+] TaurusvaluespinBox » textinteractionF... TextSelectableByMouse|LinksAccessibleBy...
#4 TaurusWheelEdit
8 TaurusModelList v sim/motor/1/position| i
TaurusValueLineEdit translatable & sim/motor/1/position
TaurusCo...LineEdit disambiguation
8 Graphica...cewidget Comment del
% TaurusV...omboBox USEI?BIEHFMO € -
=

5. State Indicator using TaurusLed

Create a new Label for displaying a name of the attribute (State).

Create a new TaurusLed. In the property Editor, change its value of “model” to

“sim/motor/1/state”, where again “sim/motor/1” defines the device.

6. Status Readout

Repeat the “Attribute Readout” part for an attribute “status”
7. Attribute Input

Here, you will create a spin box, used for writing a value to an attribute of the device.

Create a new TaurusValueSpinBox (first of the Taurus Input widgets). In the Property Editor,
change its value of “model” to “sim/motor/1/position”, where “sim/motor/1” defines the device

and “position” defines the attribute.

8. Command Button

Here, you will create a button that will execute a command on the device.

Create a new TaurusCommandButton. In the property Editor, set the value of “model” to
“sim/motor/1”. This defines a device. Change the value of “command” to a name of a command,

for instance “StepDown”.

9. Generate Code

After saving the *.ui file in the designer, execute the command for generating the python code.

cd /ProjectPath
taurusuic4 -x -o ui name.py fileName.ui
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10. Execute the code

python ui name.py

11. Testing the client

If everything was properly set, your GUI client should look similar to:

. Form Form
Sim Motor Sim Motor
;StepDowg, StepUp StepDown _ StepUp
State: e State: 0
Status: .~ DeviceisOK Status: .~ DeviceisOK
Position: B (  sood - Position: 6.000

Try changing the position. Execute commands using buttons. Validate if the position, State and
Status are properly read and displayed.
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Putting it into Practice: Writing a Simple Device

Server

To conclude this introductory Tango Box user manual we will dive a bit deeper and create an actual
Tango Device Class and Device Server in C++, using the Pogo code generator.

For this example we will be creating a simple temperature sensor. Start by launching Pogo from the
Desktop.

Enter the data as in the screenshot

1. Enter Class Name (MyTemperatureSensor)

2. Project Title (idem)

3. Class Description (idem for this demo. In real world applications please describe the class
behaviour here in detail)

4. Fill in Device Class Identification information (not filling them won't allow you to OK the dialog)

5. Click on Ok.

Class Definition Window

{Class Name : MyTemperatureSensor

| Add Inheritance Class ‘

Device Class Identification Help|
_J ‘|Language : @ cpp (! Java () Python
Project Title : |MyTemperatureSensor |
Contact email * liohn.doe@tango-controls.org | ‘|Class Description:
i\ |MyTemperatureSensor =
Class family * |Acqui5itinn |v‘ H
Platform * |AII Platforms |v‘
Bus * |Not Applicable |v‘

Manufacturer [none | 4

Product Reference

[4]

Figure 9: Class Definition Window

Next we will add a Scalar Attribute that will represent our physical value we want to measure:
Temperature. All the default values (type double, read-only, etc.) are ok for our example: click OK.

Now we can generate our C++ files. Click File>Generate or ctrl-G.

¢ Set Output path to /home/guest/MyTemperatureSensor
+» Select Linux Makefile, so we can easily build the project
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Generation Preference Window

Output Path: |fhome/guest/MyTemperatureSensor|

Browse

Files to be generated :
Device Class:

Linux:
Windows:

Documentation:

® XMI file ® Code files
® Makefile
) VC8 Project 0 VCO Project ) VC10 Project

) html Pages

Figure 10: Scalar Attribute creation and Generation Preference Window

Launch terminal

cd MyTemperatureSensor/
make

The code is compiled.

cd bin/

In the bin directory there is an executable MyTemperatureSensor executable. This is a device sever.
Run the device server with an instance, msti, in this case:

./MyTemperatureSensor mtsi

However, the device server has not been registered so you get an error message.

guest@tangobox:~/MyTemperatureSensor /bin$ . /MyTemperatureSensor mtsi
]

The device server MyTemperatu

Sensorfmtsi is not defined in database. Exiting!

guest@tangobox:~/MyTemperatureSensor/bin% I
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Launch Jive and go to the Server Wizard to register the device server (MyTemperatureServer) and its
instance (mtsi).

File Edit Tools Filter

Class rAIias rPrcperty |
Senver Device

Tango Device Installation Wizard on tangobox:10000

.

Server Registration

This wizard helps you to install a Tango device, First,
you have to enter the "Server name" (executable file
name) and its "instance name".

To register the server, click [Mext].

H-
cl

.

B
=

H-
cl

2

AR RRARR]
2t

£44

Server name emperatureSensor]
Instance name |mtsi -
= Back Mext = Cancel
Refresh

Click Next.



Page23

TANGO.

Connecting things together

Tango Device Installation Wizard on tangobox:10000

Start the server

The server "MyTemperatureSensor/mtsi" has been
successfully registered. ¥You have to start it now.
When done, click [Mext] to continue or [Back] to
register a new server,

= Back MNext = Cancel

Now is the right time to start our server:

In the terminal windows, run the device server with an instance, msti, in this case:

./MyTemperatureSensor mtsi

In Jive, click next on Start the server screen

Tango Device Installation Wizard on tangobox:10000

Class Selection

The server has been succesfully started and has 1

class(es) . Keep in mind that modifying exiting class
property may affect other running server.

Click [Edit Class] to edit properties of the selected

class

Click [Declare device] to continue with device

Armmlaratine

Server: MyTemperatureSensor
MyTemperatureS
ensor/mtsi

=\

< Back Edit Class Declare device Cancel

To instantiate a device, we need to select its Class type. In this case there is just one Class type in our
Device Server (but remember there can be more). Select MyTemperaturSensor and click Declare
Device.
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Tango Device Installation Wizard on tangobox:10000

Device Declaration of Class "MyTemp...

It is now time to give a device name for the
'MyTemperatureSensor' class, If this device does not
already exit, it will be added. Otherwise, the server's
device list remains unchanged.

Click [Mext] to edit device properties.

Device name sim/ftemp/1 -

= Back MNext = Cancel

1. Enter device name: sim/temp/1

Note: for the purpose of this demo you could any string consisting of 3 fields, separated by slashes.
The aim of this naming system for big real-world systems is to allow you to construct a logical
domain/family/member hierarchy of Devices that is fully independent of the physical Device Server
Layout.

2. Click Next
3. Finish
4. Click Yes on "Would you like to reinitialize the server?"

MyTemperatureSensor now appears in list of device servers in Jive. Right click on Temperature and
select Monitor Device. Temperature is 0 as expected, we declared an attribute but did not
implement anything that would change its value
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Jive 4.24 [tangobox:10000]

File Edit Tools Filter

Class | Alias | Property | /[ Device Info
Server I Device | if||- Device Info -----oorooooooo

o % DataBaseds Device: sim/temp/l
o ‘;ﬁ" LimacChDs i ftype_1d: IDL:Tango/Device_4:1.0
o % MacroServer i|||i1op_version: 1.2 .
9 %., MyTemperatureSensor | |host tangobox.local (192,.168.149,132)

LT — il|port: 42151

¥ mtsi i |server: MyTemperatureSensor/mtsi
¢ ﬂMyTe_,meratureSensor ‘||lserver pID: 7858
? @ i [Exported: true
o= E:I FProperties ||[Last_exported: 2nd July 2013 at 09:57:57
&t Polling i||Last_unexparted: ?

B Event
By attribute config
- % Attribute properties

Logging

- Polling Status -----c-c-memcmeme e eee e

% Pool

% PySignalsimulator
% SimMotor

%5 Starter

& TangoAccessControl
o % TangoTest

LA

Refresh

Figure 11: Device server M\yTemperatureSensor has a device class sim/temp/1

We can now modify the code to introduce some changes to the temperature and make the demo
meaningful.

Before we change the code, stop the device server (Ctrl-z in the terminal where it is running).

For the purpose of this demo you can keep using make and simple text
editing: just navigate to the source files with Files and edit them with right-
Note click>Open With=>GNU Emacs.

If you prefer you can skip the section on Eclipse




Launch eclipse.

File=> Import—> Existing Code as Makefile Project

Select

Creates a new Makefile project in a directory containing existing code

Select animport source:

|

» = General
Y= C/C++
C/C++ Executable
& ¢/C++ Project Settings
Existing Code as Makefile Project
P = CVS
» = Git
» = Install
» = Maven

@ <Back  |[NExESI cancel

Browse to MyTemperatureSensor, just select the top directory and OK.

Select Linux GCC as Toolchain and Finish

Window—>Open Perspective>C/C++ and things should look like this:

te

By | v

a

Connecting

things togethe

TANGO.

T

B  4-Plugin Development ¢ PyDev %5Debug M@ c/C++

File Edit Sou
= #
[25 Project Explorer % = A
B % M

> 1 pytest
¥ = MyTemperatureSensor
» ¥ Binaries
¥ il Includes
* = bin
> @zobj
> [g ClassFactory.cpp
> [¢ main.cpp
» [¢] MyTemperatureSensor.cpp
» [ MyTemperatureSensorClass.cpp
» [6 MyTemperatureSensorClass.h
» [¢ MyTemperatureSensorstateMa:
[ Makefile
[E/ Makefile.bck
[¥] MyTemperatureSensor.xmi

¥

& MyTemperatureSensor.h &2 =
@ I PROTECTED REGION ID(MyTemperatureSensor.h) ENABLED START -- [-/®
#ifndef MYTEMPERATURESENSOR_H
#define MYTEMPERATURESENSOR_H =
2 #include <tango.h> =
=
[ PROTECTED REGION END ----- */ =
o px*
* MyTemperatureSensor class Description: =
* MyTemperatureSensor =
%/
= namespace MyTemperatureSensor_ns
fre---- PROTECTED REGION ID(MyTemperatureSensor::Additional Cla:l-

Hl Problems &2 2 T

9errors, 1 warning, 0 others
Description
» @ Errors (9 items)

Resource

[W /MyTemperatureSensor/MyTemperatureSensor.h

Page26

Path

v

Location

o % = g

S T

# MYTEMPERATURESI
M tango.h
¥ @ MyTemperatureSen
¥ &3 MyTemperatureSe
o attr_Temperatur
MyTemperature!
MyTemperature!
MyTemperature!
~MyTemperaturt
delete_device():
init_device() : vo
always_executec
read_attr_hardw

[

v

v = 7

Type
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1. Inthe MyTemperatureSensor.cpp file
a. Add initialization code in void MyTemperatureSensor::init_device()

Existing Code New Code

// Initialize device // Initialize device
set state (Tango::0N) ;
*attr Temperature read = 5;

b. Set the variable to increase in
void MyTemperatureSensor::read_Temperature(Tango::Attribute &attr)

Existing Code New Code

*attr Temperature read += 1;

// Set the attribute value // Set the attribute value
attr.set value (attr_Temperature read) ; attr.set value (attr Temperature read);

Project->Build project or make in terminal

Restart device server

In Jive, monitor device to confirm that the temperature changes (increases).
With AtkMoni you can visualize the linear temperature increase.

ukhwn

search Project Run Window Help
A R A A ST S I S o= A e A A Sl i
Q |il ®  <-PluginDevelopment @ Pyev 35Debug |Ec/ce+
{ i g o PYD g | Bc/cr]
(& Project Explorer % | = B | [ MyTemperatureSensor.cpp 8 I MyTemperatureSensorh = n ||Eox @M BT = o
2% < B A e w o
» ¢ pytest - s
¥ S MyTempProject e

* Read Temperature attribute

» @l Includes * Description:
» @ bin *
> & obj * Data type: Tango::DevDouble

* Attr type: Scalar
» [¢ ClassFactory.cpp +

» [8 main.cpp e R A~ R SR

: F Trends
> [ MyTemperatureSensor.cpp \zud MyTemperatureSensor::read Temperature(Tango::Attribute &attr)

m =
¥ {# MyTemperatureSensor.h DEBUG_STREAM << "MyTemperatureSensor: : read Temperature(Tango: :Attribute & ‘E @
» [§ MyTemperatureSensorClass.cpp /¥ PROTECTED REGION ID(MyTemperatureSensor::read Temperature) ENABLE © D Trend
» [8 MyTemperatureSensorClass.h // Set the attribute value ¢ (3 sim/temp/1
» [§ MyTemperatureSensorStateMac attr Temperature read += 1; [ Temperature ||

[ Makefile attr.set_value(&attr Temperature read); il 0
. |
[¥ MyTemperatureSensor.xmi /%----- PROTECTED REGION END ----- */  // MyTemperatureSensor: :read Tem|
}
oD
f. Problems ¥ Tasks B Console % = Properties 4 ¢ @ o)

CDT Build Console [MyTempProject]

09:53:01 **** Incremental Build of configuration Default for project MyTempProject
make all

Creating directories ./bin/

Linking TANGO device server ./bin//MyTemperatureSensor ...

g++ ./obj/MyTemperatureSensor.o ./obj/MyTemperatureSensorClass.o ./obj/MyTemperature
ClassFactory.o ./obj/main.o -L/usr/local/lib -ltango -llog4tango -L/usr/local/’
lomniORB4 -lomniDynamic4 -lomnithread -lzmq -1ldl -lpthread -lstdc++ -o ./bin//MyTem|

09:53:02 Build Finished (took 894ms)

[ /MyTempProj P h

Figure 12: Temperature is seen to increase
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Tips and Tricks

The Tango Box image is configure with persistent storage on, changes you make are saved. When you
shut down and restart, you continue where you left off, useful when you use it for development
purposes. | you intend to use the Tango Box for demonstrations, you might want to start from the
exact same image every time again, to avoid the notorious "demo effect".

The way to do this is to add this line to the scsi0 section of the .vmx file:

scsi@:0.mode = "independent-nonpersistent”




